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iOS & macOS · Reference Checklist

App Store Submission
Complete Checklist
Bundle ID → IAP products → RevenueCat keys → Screenshots → Live

■ Click any checkbox to mark a step complete in the interactive HTML version.

■ Checks are saved locally in your browser via localStorage. Nothing sent to a server.

■ Progress bar and per-phase counters update live as you check off steps.

■ To start over use Reset All Checks in the HTML footer before a new submission.

PHASE 01
Developer Account & App ID

1.1 [iOS + Mac] Enroll in Apple Developer Program

$99/year covers both iOS and macOS distribution. Organizations also need a D-U-N-S number — allow up to a week for
verification.

Enroll: developer.apple.com/programs/enroll

1.2 [iOS + Mac] Choose Your App Name

Max 30 characters. Must be unique across the App Store — iOS and Mac share the same namespace. The name cannot
change post-publish without submitting a new version.

30 char max · Must be unique across both iOS and Mac App Store

1.3 [iOS + Mac] Register a Bundle ID (App ID)

Reverse-domain format: com.DOMAIN.appname. Use an Explicit App ID — not a wildcard — because In-App Purchases
require it. Enable the In-App Purchases capability here.

For Mac Catalyst: same Bundle ID as your iOS app. For a native macOS app: separate Bundle ID (e.g.
com.DOMAIN.appname-mac) or reuse the same if shipping as Universal Purchase.

Register: developer.apple.com/account/resources/identifiers/list

■ Explicit App ID required for IAP — wildcard will not work

1.4 [iOS + Mac] Create the App in App Store Connect

New App → select platform (iOS, macOS, or both) → choose Bundle ID → enter SKU (internal-only string, e.g.
APPNAME-001). Universal Purchase lets one record ship on both iOS and Mac.

Create: appstoreconnect.apple.com → My Apps → +

1.5 [macOS] Decide: Mac Catalyst vs Native macOS

Mac Catalyst Take your SwiftUI/UIKit app to Mac with minimal extra code. Same Bundle ID. One codebase. Enabled in
Xcode: General → Deployment → Mac.

Native macOS Separate target using AppKit or SwiftUI. Separate Bundle ID and App Store record (unless Universal
Purchase). More work, more Mac-native feel.

Reference: developer.apple.com/mac-catalyst
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PHASE 02
Xcode Project Configuration

2.1 [iOS + Mac] Set Bundle Identifier

Xcode → Target → Signing & Capabilities → Bundle Identifier. Must match exactly what you registered in step 1.3. For Mac
Catalyst, Xcode may append .macos — verify it matches your registered ID.

■ Mismatch causes code signing failures at archive time

2.2 [iOS + Mac] Set Signing Team

Signing & Capabilities → Team → select your developer account. Enable Automatically manage signing. For multi-target
projects (iOS + macOS), set the team on each target separately.

2.3 [iOS + Mac] Add In-App Purchase Capability

Signing & Capabilities → + Capability → search "In-App Purchase" → add it. For a multi-target project, add this capability to
each target that will present purchases.

■ Required on every target that initiates purchases — IAP will silently fail without it

2.4 [macOS] Add App Sandbox Capability

Required for all Mac App Store submissions. Signing & Capabilities → + Capability → App Sandbox. Configure the minimum
entitlements your app actually needs (network access, file access, etc.).

Reference: developer.apple.com/documentation/security/app_sandbox

■ Required for Mac App Store — not optional

2.5 [macOS] Enable Hardened Runtime

Required for Mac App Store and notarization. Signing & Capabilities → + Capability → Hardened Runtime. Most SwiftUI apps
need no exceptions.

Reference: developer.apple.com/documentation/security/hardened_runtime

2.6 [macOS] Set Minimum macOS Deployment Target

General → Deployment → macOS. RevenueCat SDK requires macOS 10.13+. StoreKit 2 requires macOS 12+.

RevenueCat min: macOS 10.13 · StoreKit 2: macOS 12+

2.7 [iOS + Mac] Add StoreKit Configuration File (Testing)

File → New → StoreKit Configuration File. Define your products here to test purchase flows locally. Enable per scheme: Run →
Options → StoreKit Configuration.

✓ Testing only — not shipped or needed in production

2.8 [iOS + Mac] Add RevenueCat SDK via Swift Package Manager

File → Add Package Dependencies → paste URL → add RevenueCat library to every target that needs it.

SPM URL: github.com/RevenueCat/purchases-ios

✓ Supports iOS 13+ and macOS 10.13+
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2.9 [iOS + Mac] Initialize RevenueCat in App Entry Point

import RevenueCat

Purchases.configure(withAPIKey: "YOUR_REVENUECAT_PUBLIC_KEY")

// Optional — useful during development:

Purchases.logLevel = .debug

For Mac Catalyst the same @main App struct runs on both platforms. For separate targets, initialize in each entry point using its
own RevenueCat API key.

PHASE 03
In-App Purchases & Subscriptions

3.1 [iOS + Mac] Navigate to Monetization in App Store Connect

In-App Purchases covers non-consumables and consumables. Subscriptions covers auto-renewable tiers. Both platforms share
the same IAP products when using Universal Purchase.

Navigate: appstoreconnect.apple.com → [Your App] → Monetization

3.2 [iOS + Mac] Create a Subscription Group

All auto-renewable subscriptions must belong to a group. A user can hold only one active subscription per group — this is how
upgrade/downgrade logic works. Group name is shown in system dialogs.

Group name max 30 chars · Example: "App Name Pro Access"

3.3 [iOS + Mac] Create Each Purchase / Subscription Tier

Repeat for every tier (Monthly, Annual, Lifetime, etc.):

Product ID Reverse-domain string, e.g. com.DOMAIN.appname.pro_annual

Reference Name Internal only — never shown to users

Duration 1 week / 1 month / 2 months / 3 months / 6 months / 1 year

Price Set via Apple pricing matrix — currency conversion is automatic

Display Name User-facing, localizable. Max 30 chars.

Description User-facing, localizable. Max 45 chars.

Sub Level Hierarchy within the group for upgrade/downgrade

3.4 [iOS + Mac] Add IAP Review Screenshot for Each Product

Apple requires a screenshot showing exactly where and how the purchase appears in your app. One required per product.
Internal review only — never shown to customers.

IAP Review Screenshot 640 × 920 px minimum JPEG or PNG · One per product · Internal review only

■ Missing screenshot blocks product approval

3.5 [iOS + Mac] Set Free Trial / Introductory Offer

Under each subscription product: Add Introductory Offer → Free Trial, Pay Up Front, or Pay As You Go → set duration and
eligibility.

✓ RevenueCat manages trial eligibility server-side automatically
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3.6 [iOS + Mac] Save & Submit Each Product for Review

Products are reviewed independently from the app binary. Status: Missing Metadata → Ready to Submit → Waiting for Review
→ Approved.

PHASE 04
App Store Screenshots & Preview Assets

4.1 [iOS] iPhone Screenshot Sizes

Provide at minimum one large iPhone set. The 6.9" set covers all newer iPhones when no device-specific sets are provided.

iPhone 6.9" (16 Pro Max)

1320 × 2868 px

Portrait · REQUIRED — newest size
as of 2024

iPhone 6.7" (15 / 14 Plus)

1290 × 2796 px

Portrait · Optional if 6.9" provided

iPhone 6.5" (11 Pro Max)

1242 × 2688 px

Portrait · Required — covers older
large iPhones

iPhone 5.5" (8 Plus / 7
Plus)

1242 × 2208 px

Portrait · Required if supporting pre-X
devices

Spec reference: developer.apple.com/help/app-store-connect/reference/screenshot-specifications

JPEG or PNG · sRGB or P3 · Up to 10 screenshots per size

4.2 [iOS] iPad Screenshot Sizes (if iPad supported)

iPad Pro 13" M4

2064 × 2752 px

Portrait · Required if iPad supported

iPad Pro 12.9" 3rd / 4th
gen

2048 × 2732 px

Portrait · Required if iPad supported

4.3 [macOS] Mac Screenshot Sizes

Mac screenshots are landscape. Provide at least one required size.

Mac 16" / large display

2880 × 1800 px

Landscape · REQUIRED for Retina

Mac standard

1280 × 800 px

Landscape · Required — minimum
accepted

Mac mid-size

1440 × 900 px

Landscape · Optional

Mac Retina mid

2560 × 1600 px

Landscape · Optional

■ Mac Catalyst apps still need Mac-sized landscape screenshots — not iPhone-sized
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4.4 [iOS + Mac] Recommended Screenshot Order for Apps with Purchase Tiers

Screenshot 1 — Hero: core value prop. Hook immediately.

Screenshot 2 — Key feature #2

Screenshot 3 — Key feature #3

Screenshot 4 — Paywall / subscription screen — show tiers clearly

Screenshot 5+ — Supporting features, power user views

Reviewers compare paywall screenshot here against the IAP review screenshot in step 3.4 — keep them consistent.

4.5 [iOS + Mac] How to Capture Screenshots

iOS Simulator → Device menu → Trigger Screenshot (■S) → saves to Desktop

iOS real device → Side + Volume Up → syncs via Finder

macOS → Screenshot app (■■5) or Xcode → Debug → Capture Screenshot

Xcode Organizer → Window → Organizer → Screenshots tab

4.6 [iOS] App Preview Video (optional)

15–30 seconds of real screen recording. Autoplays in search results.

6.9" iPhone 886 × 1920 px · 30fps · H.264 or HEVC

6.5" iPhone 886 × 1920 px · 30fps

5.5" iPhone 886 × 1920 px · 30fps

Mac App Store does not support preview videos

PHASE 05
RevenueCat Setup & API Keys

5.1 [iOS + Mac] Create RevenueCat Account & Project

Sign up → New Project → name it after your app. A single project holds multiple platforms (iOS, macOS, Android) sharing
entitlements and subscriber data.

Sign up: app.revenuecat.com/signup

5.2 [iOS + Mac] Add Apps to the RevenueCat Project

Project Settings → Apps → Add App. Add one entry per platform:

iOS app Apple App Store → enter iOS Bundle ID → get iOS Public API Key (starts with "appl_")

macOS app Apple App Store → enter macOS Bundle ID → get macOS Public API Key

Mac Catalyst Same Bundle ID as iOS — you can use the same API key

✓ Public keys are safe to embed in the app bundle — they are not secrets

5.3 [iOS + Mac] Generate an App Store Connect In-App Purchase Key

Users and Access → Integrations → In-App Purchase tab (separate from the regular API Keys tab). One key covers both iOS
and macOS apps in the same ASC account.

Navigate: appstoreconnect.apple.com → Users and Access → Integrations → In-App Purchase

What you get .p8 private key file · Key ID (10-char string) · Issuer ID (UUID)

Store safely Password manager — never commit the .p8 to version control

■ Download the .p8 immediately — it cannot be re-downloaded after closing the page
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5.4 [iOS + Mac] Enter the Key in RevenueCat

RevenueCat Dashboard → each app → App Store Connect section → paste Key ID and Issuer ID, upload the .p8.

Docs: revenuecat.com/docs/service-credentials/itunesconnect-app-specific-shared-secret

5.5 [iOS + Mac] Configure Entitlements in RevenueCat

Entitlements are feature-unlock gates (e.g. "pro"). Multiple products at different prices all map to the same entitlement.

Entitlement ID "pro" — this string is checked in Swift code to gate features

Cross-platform Entitlements are shared across iOS and macOS entries in the same project

Docs: revenuecat.com/docs/entitlements

5.6 [iOS + Mac] Configure Offerings in RevenueCat

Offerings are named bundles of packages shown on your paywall. The Current offering is fetched by default. Create separate
offerings per platform if your Mac and iOS paywalls differ.

Docs: revenuecat.com/docs/offerings

✓ Offerings can be swapped remotely — no app update needed

5.7 [iOS + Mac] Gate Features by Entitlement in Swift

let customerInfo = try await Purchases.shared.customerInfo()

if customerInfo.entitlements["pro"]?.isActive == true {

// unlock pro features — same code on iOS and macOS

}

PHASE 06
App Store Listing & Metadata

6.1 [iOS + Mac] App Icon

Supply a single 1024 × 1024 px PNG in App Store Connect. Xcode generates all device sizes from the AppIcon asset catalog.
No alpha channel. No pre-applied rounded corners — Apple applies its own mask.

iOS / iPadOS 1024 × 1024 px · PNG · no alpha · Apple applies rounding

macOS 1024 × 1024 px · PNG · Apple applies the squircle mask — design with safe margins

6.2 [iOS + Mac] Name, Subtitle & Description

Name 30 chars max

Subtitle 30 chars — keyword-rich, shown under name in search

Description 4000 chars · First 3 lines visible before "more" — lead with value prop

Promotional Text 170 chars · Updatable anytime without a new version submission

6.3 [iOS + Mac] Keywords

100 characters total, comma-separated, no spaces around commas. Don't repeat words in the name or subtitle. Don't use
competitor names.

100 char total budget · No spaces around commas · No repeats from name/subtitle



APP STORE SUBMISSION — COMPLETE CHECKLIST iOS + macOS · April 2026

appstoreconnect.apple.com · developer.apple.com · revenuecat.com Page 7

6.4 [iOS + Mac] URLs & Contact Info

Support URL Required. Contact form, support page, or mailto: link.

Privacy Policy URL Required if app collects any data (RevenueCat does). Must be live before submission.

Marketing URL Optional. Link to your app landing page.

Quick generator: privacypolicygenerator.info

■ Privacy Policy URL must be publicly live at review time

6.5 [iOS + Mac] Age Rating

Complete the content questionnaire. Most utility apps land at 4+. Answer honestly — Apple cross-checks at review.

6.6 [iOS + Mac] App Privacy (Nutrition Label)

Declare every data type your app and its SDKs collect. RevenueCat collects Purchase History, User ID, and Device ID — all
must be declared.

RevenueCat privacy docs: revenuecat.com/docs/getting-started/privacy

■ Inaccurate declarations are grounds for App Store removal

6.7 [iOS + Mac] Upload Screenshots in App Store Connect

App Store Connect → your app → App Store → [version] → drag screenshots into each device slot. iOS and macOS
screenshots are uploaded in separate sections even for Universal Purchase apps.

Navigate: appstoreconnect.apple.com → [App] → App Store → [Version]

PHASE 07
Build, TestFlight & Submit for Review

7.1 [iOS + Mac] Bump Version & Build Number

Version (CFBundleShortVersionString) is user-facing, e.g. 1.0.0. Build (CFBundleVersion) must increment with every upload.
Set both on every target before archiving.

Build number must exceed any previous upload — even if version stays the same

7.2 [iOS] Archive for iOS

Set scheme destination to Any iOS Device (arm64) — not Simulator. Product → Archive → Xcode Organizer opens
automatically.

■ Must target a device — Simulator builds cannot be uploaded to App Store Connect

7.3 [macOS] Archive for macOS

Set scheme destination to My Mac (for Mac Catalyst: "My Mac (Designed for iPad)" or "My Mac"). Product → Archive.

For Mac Catalyst, Xcode may show multiple Mac destination options — pick "My Mac"

7.4 [iOS + Mac] Validate the Archive

Organizer → select archive → Validate App. Catches entitlement mismatches, missing privacy manifests, and binary issues.
For macOS, also checks Hardened Runtime and sandbox entitlements.

■ Fix all errors before uploading — Notarization will fail on the same issues
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7.5 [iOS + Mac] Upload to App Store Connect

Organizer → Distribute App → App Store Connect → Upload. For macOS, Xcode also notarizes the binary automatically. Allow
10–30 min for processing.

macOS notarization is handled automatically by Xcode during ASC upload

7.6 [iOS] TestFlight — Internal Testing (iOS)

Build appears in TestFlight → Internal Groups after processing. Up to 100 internal testers. No review required. Confirm
RevenueCat sandbox purchases work end-to-end here.

TestFlight: appstoreconnect.apple.com/testflight

7.7 [macOS] TestFlight for Mac

Mac apps also use TestFlight since macOS 12. Build appears separately under the macOS platform in TestFlight. Internal
testers install via the TestFlight Mac app.

Reference: developer.apple.com/testflight

Requires macOS 12+ on tester's machine

7.8 [iOS + Mac] Select Build & Fill In Review Information

Sign-In Required If auth required, supply test account — username and password

Notes for Reviewer Explain how to reach the IAP, what the free tier covers, anything non-obvious. Reviewers will not spend
real money.

IAP testing note Reviewers use the sandbox — full purchase UI must be reachable without completing a real transaction

7.9 [iOS + Mac] Submit for Review

Click Add for Review → confirm. Status: Waiting for Review. First submissions: 1–3 business days.

Review times: developer.apple.com/news/releases

Average first review: 1–3 business days for both iOS and Mac

7.10 [iOS + Mac] Post-Approval: Release & Production Checks

Manually Release This Version lets you control go-live timing. After release, confirm RevenueCat S2S notifications are firing in
production for both platforms.

S2S setup: revenuecat.com/docs/platform-resources/apple-platform-resources/apple-server-to-server-notifications

✓ Configure S2S webhooks before launch for reliable subscription status
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QUICK REFERENCE — KEY URLS

Bundle ID Registration developer.apple.com/account/resources/identifiers/list

App Store Connect appstoreconnect.apple.com

ASC In-App Purchase Keys appstoreconnect.apple.com/access/integrations/api

RevenueCat Dashboard app.revenuecat.com

RevenueCat — Entitlements revenuecat.com/docs/entitlements

RevenueCat — Offerings revenuecat.com/docs/offerings

RevenueCat Privacy Docs revenuecat.com/docs/getting-started/privacy

Screenshot Specifications developer.apple.com/help/app-store-connect/reference/screenshot-specifications

RevenueCat iOS SDK (SPM) github.com/RevenueCat/purchases-ios

Mac Catalyst Docs developer.apple.com/mac-catalyst

App Sandbox Reference developer.apple.com/documentation/security/app_sandbox

Hardened Runtime developer.apple.com/documentation/security/hardened_runtime

Privacy Policy Generator privacypolicygenerator.info

Review Time Transparency developer.apple.com/news/releases


